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Steps to Upgrade Your Current MonitorIT to the Latest Version  

 
There are seven different Upgrade scenarios based on your current MonitorIT version: 
(See the screen-shots at the end of this document for determining your current 
MonitorIT version number, if you are unsure), 

Go to section (0) if your current MonitorIT version is 8.0.00 or greater; 
Go to section (1) if your current MonitorIT version is 6.0.00 or greater; 
Go to section (2) if your current MonitorIT version is 5.2.06 through 5.2.16; 
Go to section (3) if your current MonitorIT version is 5.2.00 through 5.2.05; 
Go to section (4) if your current MonitorIT version is 5.1.00 through 5.1.06; 
Go to section (5) if your current MonitorIT version is 5.0.02 through 5.0.12; 
Go to section (6) for all versions earlier than 5.0.02. 

 
(0) Only if your current MonitorIT version is 8.0.00 / 9.0.00 or greater, then: 

v Run “MonitorIT_FullSetup.exe”, from the folder where you downloaded and 
saved, to start the installation program for the new version, and follow the on-
screen install directions.   

v Choose the same directory to install the new version over the current version; 
your current configuration and database information are preserved. 

v Your upgrade is now complete!  At the prompt at the end of Setup about 
restarting the MonitorIT Server service (if you were previously running the 
MonitorIT Server as a service), choose OK, and your MonitorIT Server 
service is restarted and back up and running with the new version 

 
 

(1) Only if your current MonitorIT version is 6.0.00 / 7.0.00 or greater, then: 
v Run “MonitorIT_FullSetup.exe”, from the folder where you downloaded and 

saved, to start the installation program for the new version, and follow the on-
screen install directions.   

v Choose the same directory to install the new version over the current version; 
your current configuration and database information are preserved. 

v Your upgrade is now complete! At the prompt at the end of Setup about 
restarting the MonitorIT Server service, choose “No”, because you have to 
enter your new license key. 

v Restart the MonitorIT Server component, as a foreground application by 
double-click on the ‘MonitorIT Server’ web icon on the desktop, and enter 
your new 8.0 license key, then exit and start the MonitorIT Server service 
using the Windows Services utility. 
 
 

(2)  Only if your current MonitorIT version is 5.2.06 through 5.2.16, then: 
v Run “MonitorIT_FullSetup.exe”, from the folder where you downloaded and 

saved, to start the installation program for the new version, and follow the on-
screen install directions.   
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v Choose the same directory to install the new version over the current version; 
your current configuration and database information are preserved.  

v At the prompt at the end of Setup about restarting the MonitorIT Server 
service, choose “No”, because you have to update your existing database with 
two new tables to use the new ‘CustomWatch’ feature, and you have to enter 
your new license key. 
 
If using the default Access database go to the “…\MonitorIT\Database” 
folder: 
A.) Start Access and open up your current MonitorIT database, which is 
named ”Rpm.mdb”. 
 
B.) Under “Objects” in the Access interface, make sure “Tables” are selected. 
 
C.) In the table view pane, right-click with the mouse and select “Import”. 
 
D.) Navigate to and select the database called “NewTablesIn60.mdb” found in 
the “…\MonitorIT\Database” folder also; double-click to open and display the 
“Import Objects” dialogue box. 
 
E.) In the “Import Objects” dialogue box, in the “Tables” tab, select the 
“CustomCheckLogData” and “CustomCheckMonitor” tables.  Click the “OK” 
button; then Exit Access.  The two new tables are added and saved. 
 

v Your upgrade is now complete! Restart the MonitorIT Server component, as a 
foreground application by double-click on the ‘MonitorIT Server’ web icon on 
the desktop, and enter your new 7.0 license key, then exit and start the 
MonitorIT Server service using the Windows Services utility. 
 
If using SQL Server for your MonitorIT database: 
A.) Start Enterprise Manager, and from the ‘Tools’ menu, select ‘SQL Server 
Query Analyzer’; 
 
B.) In the ‘DB:’ (database) selection box at the top, make sure your current 
MonitorIT database is selected, usually called ‘MonitorIT’; 
 
C.) Open and load the SQL Script called ‘CreateCustomWatchTables.sql’, 
then execute this script by clicking the green arrow to start; 
 
D.) Exit the ‘SQL Server Query Analyzer’; your done. 
 

v Your upgrade is now complete! Restart the MonitorIT Server component, as a 
foreground application by double-click on the ‘MonitorIT Server’ web icon on 
the desktop, and enter your new 7.0 license key, then exit and start the 
MonitorIT Server service using the Windows Services utility. 
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(3) Only if your current MonitorIT version is 5.2.00 through 5.2.05, then: 

v Run “MonitorIT_FullSetup.exe”, from the folder where you downloaded and 
saved, to start the installation program for the new version, and follow the on-
screen install directions.   

v Choose the same directory to install the new version over the current version; 
your current configuration and database information are preserved.  

v At the prompt at the end of Setup about restarting the MonitorIT Server 
service, choose “No”, because you have to update your existing database with 
new tables to use the new WMI Hardware Configuration feature and the 
CustomWatch feature; and you have to enter your new license key. 
 
If using the default Access database go to the “…\MonitorIT\Database” 
folder: 
A.) Start Access and open up your current MonitorIT database, which is 
named ”Rpm.mdb”. 
 
B.) Under “Objects” in the Access interface, make sure “Tables” are selected. 
 
C.) In the table view pane, right-click with the mouse and select “Import”. 
 
D.) Navigate to and select the database called “NewTablesIn52.mdb” found in 
the “…\MonitorIT\Database” folder also; double-click to open and display the 
“Import Objects” dialogue box. 
 
E.) In the “Import Objects” dialogue box, in the “Tables” tab, select the 
“WMIConfiguration” table.  Click the “OK” button; then Exit Access.  The 
one new table is added and saved. 
 
F.) Repeat step C) above, then Navigate to and select the database called 
“NewTablesIn60.mdb” found in the “…\MonitorIT\Database” folder also; 
double-click to open and display the “Import Objects” dialogue box. 
 
G.) In the “Import Objects” dialogue box, in the “Tables” tab, select the 
“CustomCheckLogData” and “CustomCheckMonitor” tables.  Click the “OK” 
button; then Exit Access.  The two new tables are added and saved. 
 

v Your upgrade is now complete! Restart the MonitorIT Server component, as a 
foreground application by double-click on the ‘MonitorIT Server’ web icon on 
the desktop, and enter your new 7.0 license key, then exit and start the 
MonitorIT Server service using the Windows Services utility. 
 
If using SQL Server for your MonitorIT database: 
A.) Start Enterprise Manager, and from the ‘Tools’ menu, select ‘SQL Server 
Query Analyzer’; 
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B.) In the ‘DB:’ (database) selection box at the top, make sure your current 
MonitorIT database is selected, usually called ‘MonitorIT’; 
 
C.) Open and load the SQL Script called ‘CreateWMIConfigurationTable.sql’, 
then execute this script by clicking the green arrow to start; 
 
D.) Open and load the SQL Script called ‘CreateCustomWatchTables.sql’, 
then execute this script by clicking the green arrow to start; 
 
E.) Exit the ‘SQL Server Query Analyzer’; your done. 
 

v Your upgrade is now complete! Restart the MonitorIT Server component, as a 
foreground application by double-click on the ‘MonitorIT Server’ web icon on 
the desktop, and enter your new 7.0 license key, then exit and start the 
MonitorIT Server service using the Windows Services utility. 

 
 

(4) Only if your current MonitorIT version is 5.1.00 through 5.1.06, then: 
v Run “MonitorIT_FullSetup.exe”, from the folder where you downloaded and 

saved, to start the installation program for the new version, and follow the on-
screen install directions.   

v Choose the same directory to install the new version over the current version; 
your current configuration and database information are preserved.  

v At the prompt at the end of Setup about restarting the MonitorIT Server 
service, choose “No”, because you have to update your existing database with 
new tables to use the new “CustomWatch” and “ProcessWatch” features, and 
the WMI Hardware Configuration feature, and you have to enter your new 
license key. 
 

v If using the default Access database go to the “…\MonitorIT\Database” 
folder: 
A.) Start Access and open up your current MonitorIT database, which is 
named ”Rpm.mdb”. 
 
B.) Under “Objects” in the Access interface, make sure “Tables” are selected. 
 
C.) In the table view pane, right-click with the mouse and select “Import”. 
 
D.) Navigate to and select the database called “NewTablesIn52.mdb” found in 
the “…\MonitorIT\Database” folder also; double-click to open and display the 
“Import Objects” dialogue box. 
 
E.) In the “Import Objects” dialogue box, in the “Tables” tab, select all which 
is just the three new tables.  Click the “OK” button; then Exit Access.  The 
three new tables are added and saved. 
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F.) Repeat step C) above, then Navigate to and select the database called 
“NewTablesIn60.mdb” found in the “…\MonitorIT\Database” folder also; 
double-click to open and display the “Import Objects” dialogue box. 
 
G.) In the “Import Objects” dialogue box, in the “Tables” tab, select the 
“CustomCheckLogData” and “CustomCheckMonitor” tables.  Click the “OK” 
button; then Exit Access.  The two new tables are added and saved. 
 

v Your upgrade is now complete! Restart the MonitorIT Server component, as a 
foreground application by double-click on the ‘MonitorIT Server’ web icon on 
the desktop, and enter your new 5.2 license key, then exit and start the 
MonitorIT Server service using the Windows Services utility. 
 

v If using SQL Server for your MonitorIT database: 
A.) Start Enterprise Manager, and from the ‘Tools’ menu, select ‘SQL Server 
Query Analyzer’; 
 
B.) In the ‘DB:’ (database) selection box at the top, make sure your current 
MonitorIT database is selected, usually called ‘MonitorIT’; 
 
C.) Open and load the SQL Script called ‘CreateProcessMonitorTable.sql’, 
then execute this script by clicking the green arrow to start; 
 
D.) Open and load the SQL Script called ‘CreateProcessLogTable.sql’, then 
execute this script by clicking the green arrow to start; 
 
E.) Open and load the SQL Script called ‘CreateWMIConfigurationTable.sql’, 
then execute this script by clicking the green arrow to start; 
 
F.) Open and load the SQL Script called ‘CreateCustomWatchTables.sql’, 
then execute this script by clicking the green arrow to start; 
 
G.) Exit the ‘SQL Server Query Analyzer’; your done. 
 

v Your upgrade is now complete! Restart the MonitorIT Server component, as a 
foreground application by double-click on the ‘MonitorIT Server’ web icon on 
the desktop, and enter your new 7.0 license key, then exit and start the 
MonitorIT Server service using the Windows Services utility. 

 
 
 

(5) Only if your current MonitorIT version is 5.0.02 through 5.0.12, then there is a 
field size or definition change in three (3) different tables that needs to be done after 
you update, and three new tables have to be imported, to effectively use the new 
“CustomWatch”, “ProcessWatch”, WMI Hardware Configuration and “Schedule 
Periodic Reports” features, and the enhancements to the ‘Manage’ Email Groups 
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feature.   The steps are straight- forward, and will only take a few minutes. If you 
prefer, call our technical support, we can walk you through making these changes in 
a minute or two as long as you have Microsoft Access 2000 or better available.   
Follow these steps below: 
 
A.) Run “MonitorIT_FullSetup.exe” from the folder where you downloaded and 
saved, to start the installation program for the new version, and follow the on-screen 
install directions. 
v Choose the same directory to install the new version over the current version; 

your current configuration and database information are preserved. 
v At the prompt at the end of Setup about restarting the MonitorIT Server service, 

choose “No”, because you have to update your existing, and you have to enter 
your new license key. 

 
B.) Open Microsoft Access 2000 or better, and go to the “...\MonitorIT\Database” 
folder and find the database file called ‘RpmAnalyze.mdb’, and open it.  This is the 
MonitorIT Reports database used by both SQL Server and Access users of 
MonitorIT’s primary database. 
v Click on the table named ‘WorkingSetHistory’ to select it, then click the 

‘Design’ menu item to open the design view of this table.  
v For the ‘RepeatEvery’ Field Name, click its Data Type, which should be 

‘Text’.  From the drop-down choices, choose ‘Memo’ to change the Data 
Type to ‘Memo’. 

v Save and then close this database. 
 
C.) If using the default Access database for your primary MonitorIT 
database, go to the “…\MonitorIT\Database” folder: 

1.) Start Access and open up your current MonitorIT database, which is 
named ”Rpm.mdb”. 
 
2.) Under “Objects” in the Access interface, make sure “Tables” are selected. 
 
3.) In the table view pane, right-click with the mouse and select “Import”. 
 
4.) Navigate to and select the database called “NewTablesIn52.mdb” found in 
the “…\MonitorIT\Database” folder also; double-click to open and display the 
“Import Objects” dialogue box. 
 
5.) In the “Import Objects” dialogue box, in the “Tables” tab, select all which 
is just the three new tables.  Click the “OK” button.  The three new tables are 
added and saved. 
 
6.) Repeat step 3) above, then Navigate to and select the database called 
“NewTablesIn60.mdb” found in the “…\MonitorIT\Database” folder also; 
double-click to open and display the “Import Objects” dialogue box. 
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7.) In the “Import Objects” dialogue box, in the “Tables” tab, select the 
“CustomCheckLogData” and “CustomCheckMonitor” tables.  Click the “OK” 
button; then Exit Access.  The two new tables are added and saved. 
 
8.) Next, click on the table named ‘EmailList’ to select it, then click the 
‘Design’ menu item to open the design view of this table. 
 
9.) For the ‘EmailAddress’ Field Name, click its Data Type, which should be 
‘Memo’.  From the drop-down choices, choose ‘Text’ to change the Data 
Type to ‘Text’.  Then on the ‘General’ tab at the bottom where the field 
parameters are displayed, change the first parameter, ‘Field Size’, to 255. 
Save it and close the table. 
 
10.) Click on the table named ‘EndUser’ to select it, then click the ‘Design’ 
menu item to open the design view of this table. 
 
11.) Click the ‘Pswd’ Field Name to select it.  Then on the ‘General’ tab at the 
bottom where the field parameters are displayed, change the first parameter, 
‘FieldSize’, to 255. 
 
12.) Save it and then close this database. 
 

D.) If using SQL Server for your primary MonitorIT database: 
1.) Start Enterprise Manager, and from the ‘Tools’ menu, select ‘SQL Server 
Query Analyzer’; 
 
2.) In the ‘DB:’ (database) selection box at the top, make sure your current 
MonitorIT database is selected, usually called ‘MonitorIT’; 
 
3.) Open and load the SQL Script called ‘CreateProcessMonitorTable.sql’, 
then execute this script by clicking the green arrow to start; 
 
4.) Open and load the SQL Script called ‘CreateProcessLogTable.sql’, then 
execute this script by clicking the green arrow to start; 
 
5.) Open and load the SQL Script called ‘CreateWMIConfigurationTable.sql’, 
then execute this script by clicking the green arrow to start; 
 
6.) Open and load the SQL Script called ‘CreateCustomWatchTables.sql’, 
then execute this script by clicking the green arrow to start; 
 
7.) Exit the ‘SQL Server Query Analyzer’;. 
 
8.) Next, in Enterprise Manager, find the MonitorIT database under the 
‘Databases’ node, expand the MonitorIT database, and select ‘Tables’.   
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9.) Right-Click on the table named ‘EmailList’ and select the ‘Design Table’ 
menu item to open the design view of this table. 
 
10.) For the ‘EmailAddress’ Field Name, click its Data Type, which should 
be ‘ntext’.  From the drop-down choices, choose ‘nvarchar’ to change the 
Data Type to ‘nvarchar’; change the ‘length’ to 255. 
 
11.) Save it, and when prompted about updating the script say “OK”. 
Right-Click on the table named ‘EndUser’ to select it, then click the ‘Design’ 
menu item to open the design view of this table. 
 
12.) Change the ‘Pswd’ length parameter to 255. Save it.  Exit Enterprise 
manager if you wish. 

 
E.) Your upgrade is now complete! Restart the MonitorIT Server component, as a 
foreground application by double-click on the ‘MonitorIT Server’ web icon on the 
desktop, and enter your new 7.0 license key, then exit and start the MonitorIT 
Server service using the Windows Services utility. 
 

 
(6) For all versions earlier than 5.0.02 (5.0.01 or less), and you want to preserve 

your current ‘Admin’ Configuration data.  Continue here only if you are 
going to use Microsoft Access or Enterprise Manager to import the new 
tables to your MonitorIT Access or SQL Server primary database, 
respectively: 
 
A.) Run “MonitorIT_FullSetup.exe” from the folder where you downloaded and 
saved, to start the installation program for the new version, and follow the on-
screen install directions. 
v Choose the same directory to install the new version over the current version. 
v If you are using SQL Server, and your current MonitorIT database file, 

MonitorIT.mdf, is residing in “…\MonitorIT\Database”, you will need to 
detach the file from SQL Server or stop SQL Server so that Setup does not 
encounter a problem. 

 
B.) If your primary MonitorIT database is Access and you are using Access 
continue with the next step; otherwise if your primary MonitorIT database is SQL 
Server and you are using Enterprise Manager, continue with Step (8) below. 
 
 

(7) Using Microsoft Access to import the new database tables to your primary 
MonitorIT Access database: 
 
A.) Start Access and open up your current MonitorIT database which was 
renamed by Setup to ”RpmOld.mdb”; it should be in the 
“…\MonitorIT\Database” folder. 
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B.) Under “Objects” in the Access UI, make sure “Tables” are selected. 
 
C.) Find the table called “Notifications”, left-click to select it, then right-click and 
choose “Delete” to delete this table. 
 
D.) In the table view pane, right-click with the mouse and select “Import”. 
 
E.) Select the new MonitorIT database which is called “Rpm.mdb”; it should be 
in the “…\MonitorIT\Database” folder also; double-click to open and display the 
“Import Objects” dialogue box.. 
 
F.) In the “Import Objects” dialogue box, in the “Tables” tab, choose the 
following tables: 
v If upgrading from a version 4.0.11 through 5.0.01, select the tables 

“CustomCheckLogData”, “CustomCheckMonitor”, “WMIConfiguration”, 
“ProcessMonitor”, “ProcessCheckLogData”, “SyslogCheckLog”, 
“SyslogMonitor” and “Notifications”. 

v If upgrading from a version 4.0.04 through 4.0.10, in addition to the eight 
tables above, also select the tables “FileCheckLogData” and 
“FileCheckMonitor”. 

v If upgrading from a version 4.0.00 through 4.0.03, in addition to the ten tables 
above, also select “EmailGroup” and “EmailList”. 

v Then click the “OK” button. 
 

G.) Finally: 
v Click on the table named ‘EmailList’ to select it, then click the ‘Design’ 

menu item to open the design view of this table. 
v For the ‘EmailAddress’ Field Name, click its Data Type.  If the Data Type is 

not ‘Text’, from the drop-down choices, choose ‘Text’ to change the Data 
Type to ‘Text’. Then on the ‘General’ tab at the bottom where the field 
parameters are displayed, change the first parameter, ‘Field Size’, to 255. 

v Click on the table named ‘EndUser’ to select it, then click the ‘Design’ menu 
item to open the design view of this table.  

v Click the ‘Pswd’ Field Name to select it.  Then on the ‘General’ tab at the 
bottom where the field parameters are displayed, change the first parameter 
‘FieldSize’ to 255. 

v Save and then close this database. 
 
H.) Using Microsoft Access 2000 or better, go to the “...\MonitorIT\Database” 
folder and find the database file called ‘RpmAnalyze.mdb’, and open it.  This is 
the MonitorIT Reports database used by both SQL Server and Access users of 
MonitorIT’s primary database. 
v Click on the table named ‘WorkingSetHistory’ to select it, then click the 

‘Design’ menu item to open the design view of this table.  
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v For the ‘RepeatEvery’ Field Name, click its Data Type, which should be 
‘Text’.  From the drop-down choices, choose ‘Memo’ to change the Data 
Type to ‘Memo’. 

v Save and then close this database. 
 
I.) Exit Access, then rename the new “Rpm.mdb” to “RpmV51.mdb”; then 
rename your current database ”RpmOld.mdb” back to “Rpm.mdb”. 
 
J.) Your upgrade is now complete! Restart the MonitorIT Server component, as a 
foreground application by double-click on the ‘MonitorIT Server’ web icon on the 
desktop, and enter your new 7.0 license key, then exit and start the MonitorIT 
Server service using the Windows Services utility. 
 

(8) Using Microsoft Enterprise Manager to import the new database tables to 
your primary MonitorIT database in SQL Server: 
 
A.) Rename the new “MonitorIT.mdf” file that was installed with 5.2 to 
“MonitorIT52.mdf”, and then add “MonitorIT52.mdf” to SQL Server by creating 
a DSN for it (these steps are detailed in the User Guide appendices). 
 
B.) Start Enterprise Manager, and expand the tree to the databases, find and 
expand the MonitorIT database, then click the ‘Tables’ to view all the MonitorIT 
database tables in the right pane; find the table called “Notifications”, left-click to 
select it, then right-click and choose “Delete” to delete this table. 
 
C.) Next right-click on the current MonitorIT database name and choose “All 
Tasks->Import Data” and run the “DTS Import Wizard”. 
 
D.) The “Source” choice should be “Microsoft OLE DB Provider for SQL 
Server” and the “Database” choice should be the new MonitorIT database 
“MonitorIT51.mdf”. 
 
E.) Click the Next button, and then the “Destination” choice should also be 
“Microsoft OLE DB Provider for SQL Server” and the “Database” choice should 
be your current MonitorIT database, presumably, “MonitorIT.mdf”. 
 
F.) Click Next and select the radio button for “Copy objects and data between 
SQL Server databases”; (SQL Server 7 says, “Transfer objects…”). 
 
G.) Click Next and then uncheck the “Copy all objects” checkbox (SQL Server 7 
says “Transfer all objects”) and then click the “Select Objects” button; then select 
the following object names (actually the new table names) based on the following: 
v If upgrading from a version 4.0.11 through 5.0.01, select the tables 

“CustomCheckMonitor”, “CustomCheckLogData”, “WMIConfiguration”, 
“ProcessMonitor”, “ProcessCheckLogData”, “SyslogCheckLog”, 
“SyslogMonitor” and “Notifications”. 



  Breakout Software       MonitorIT®  9.0       Upgrade Instructions 

Copyright 2000-2009, Breakout Technologies, Inc.  11 

v If upgrading from a version 4.0.04 through 4.0.10, in addition to the eight 
tables above, also select the tables “FileCheckLogData” and 
“FileCheckMonitor”. 

v If upgrading from a version 4.0.00 through 4.0.03, in addition to the ten tables 
above, also select “EmailGroup” and “EmailList”. 

v Then Click the OK button. 
 

H.) Click Next and then check the “Run Immediately” checkbox; then click Next, 
confirm the “Summary” and then click “Finish”, and then “Done”. 
 
I.) Finally, using Enterprise Manager and find the MonitorIT database under the 
‘Databases’ node, expand the MonitorIT database, and select ‘Tables’.   
v Right-Click on the table named ‘EmailList’ and select the ‘Design Table’ 

menu item to open the design view of this table. 
v For the ‘EmailAddress’ Field Name, click its Data Type, which should be 

‘ntext’.  From the drop-down choices, choose ‘nvarchar’ to change the Data 
Type to ‘nvarchar’; change the ‘length’ to 255. 

v Save it, and when prompted about updating the script say “OK”. 
v Right-Click on the table named ‘EndUser’ to select it, then click the ‘Design’ 

menu item to open the design view of this table. 
v Change the ‘Pswd’ length parameter to 255. 
v Save it.  Exit Enterprise manager if you wish. 
 
J.) Using Microsoft Access 2000 or better, go to the “...\MonitorIT\Database” 
folder and find the database file called ‘RpmAnalyze.mdb’, and open it.  This is 
the MonitorIT Reports database used by both SQL Server and Access users of 
MonitorIT’s primary database. 
v Click on the table named ‘WorkingSetHistory’ to select it, then click the 

‘Design’ menu item to open the design view of this table.  
v For the ‘RepeatEvery’ Field Name, click its Data Type, which should be 

‘Text’.  From the drop-down choices, choose ‘Memo’ to change the Data 
Type to ‘Memo’. 

v Save and then close this database. 
 
K.) Your upgrade is now complete! Restart the MonitorIT Server component, as a 
foreground application by double-click on the ‘MonitorIT Server’ web icon on the 
desktop, and enter your new 7.0 license key, then exit and start the MonitorIT 
Server service using the Windows Services utility. 
. 
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Determining Your Current MonitorIT Version 
You can determine your current MonitorIT version by looking for this image:  
 

 
 

…on the Introduction screen when you open bring up a MonitorIT console 
interface: 

 

 
 


